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面向嵌入式工程师的
MPLAB® XC8用户指南

面向嵌入式工程师的MPLAB® XC8用户指南

简介

本文档提供了5个适用于8位器件和MPLAB XC8 C编译器的代码示例。读者需要掌握
一些单片机和C编程语言的相关知识。

1. 点亮或熄灭LED

2. 使用_delay()函数使LED闪烁

3. 使用中断作为延时在LED上递增计数

4. 使用A/D在LED上显示电位器值

5. 在LED上显示EEPROM数据值

A 在MPLAB X IDE中运行代码

B 获取软件和硬件
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1. 点亮或熄灭LED

本示例将在带PIC16F1719单片机（MCU）的Explorer 8板上交替点亮各LED。更多 
信息，请参见第B节“获取软件和硬件”。

#include <xc.h> 

// PIC16F1719 Configuration Bit Settings

// For more on Configuration Bits, 
// consult your device data sheet

// CONFIG1
#pragma config FOSC = ECH     // External Clock, 4-20 MHz
#pragma config WDTE = OFF     // Watchdog Timer (WDT) disabled
#pragma config PWRTE = OFF    // Power-up Timer disabled
#pragma config MCLRE = ON     // MCLR/VPP pin function is MCLR
#pragma config CP = OFF       // Flash Memory Code Protection off
#pragma config BOREN = ON     // Brown-out Reset enabled
#pragma config CLKOUTEN = OFF // Clock Out disabled.
#pragma config IESO = ON      // Internal/External Switchover on
#pragma config FCMEN = ON     // Fail-Safe Clock Monitor enabled

// CONFIG2
#pragma config WRT = OFF      // Flash Memory Self-Write Protect off
#pragma config PPS1WAY = ON   // PPS one-way control enabled
#pragma config ZCDDIS = ON    // Zero-cross detect disabled
#pragma config PLLEN = OFF    // Phase Lock Loop disable
#pragma config STVREN = ON    // Stack Over/Underflow Reset enabled
#pragma config BORV = LO      // Brown-out Reset low trip point
#pragma config LPBOR = OFF    // Low-Power Brown Out Reset disabled
#pragma config LVP = OFF      // Low-Voltage Programming disabled

#define LEDS_ON_OFF 0x55 

void main(void) {

    // Port D access 

    ANSELD = 0x0; // set to digital I/O (not analog)
    TRISD = 0x0;  // set all port bits to be output
    LATD = LEDS_ON_OFF; // write to port latch - RD[0:3] = LED[0:3]

    // Port B access
    ANSELB = 0x0; // set to digital I/O (not analog)
    TRISB = 0x0;  // set all port bits to be output
    LATB = LEDS_ON_OFF; // write to port latch - RB[0:3] = LED[4:7]
    
    return;
}

1.1 头文件<xc.h>

本头文件允许源文件中的代码访问编译器或器件特定的功能。可在MPLAB XC8安装目 
录的include子目录下找到本头文件和其他头文件。

编译器将根据您选择的器件设置相应的宏，以使xc.h指向正确的器件特定头文件。请
勿将器件特定的头文件包含在您的代码中，否则将导致代码不可移植。

请参见第1.1节

请参见第1.2节

请参见第1.3节

请参见第1.4节
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1.2 配置位

Microchip器件具有配置寄存器，其中的位可用于使能和 /或设置器件功能。

要设置的配置位

请特别注意以下几项：

• 振荡器选择——该项必须与硬件的振荡器电路匹配。如果设置有误，器件时钟可能
无法运行。通常情况下，开发板使用高速晶振。示例中的相关代码如下：
#pragma config FOSC = ECH

• 看门狗定时器——建议在必要时禁止该定时器。这样可防止意外复位。示例中的相
关代码如下：
#pragma config WDTE = OFF

• 代码保护——在必要时关闭代码保护。这样可确保器件存储器可完全访问。示例中
的相关代码如下：
#pragma config CP = OFF

使用其他8位器件（而非本示例中使用的PIC16F1719 MCU）时，可能需要设置不同的
配置位。请参见具体器件数据手册了解相应配置位的名称和功能。可使用部件编号在
http://www.microchip.com上搜索相应的数据手册。

有关每款器件可用配置位的更多信息，请参见MPLAB XC8安装路径下的如下文件：

MPLAB XC8 Installation Directory/docs/chips

设置配置位的方法

在MPLAB X IDE中，可使用Configuration Bits（配置位）窗口查看和设置这些位。请
选择Window>PIC Memory Views>Configuration Bits（窗口>PIC存储器视图>配置位）
打开该窗口。

图1： 配置窗口

完成所需设置后，请单击Generate Source Code to Output（生成源代码并输出），
然后将pragma伪指令从Output（输出）窗口复制到您的代码中，如示例代码中所示。

注： 如果未正确设置配置位，器件将无法运行，或至少不按预期运行。

http://www.microchip.com
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1.3 为LED值定义宏

如下一节所述，要写入LED的值已赋值给描述性宏（LEDS_ON_OFF），即LED D1、 
D3、D5和D7将点亮，LED D2、D4、D6和D8将熄灭。有关电路板原理图（第B.4节 
“获取并设置Explorer 8板”）的信息，请参见Explorer 8 Development Board User’s     
Guide（DS40001812）。

1.4 端口访问

器件数字 I/O引脚可与外设 I/O引脚复用。为确保当前仅使用数字 I/O，需禁止其他外
设。为此，可使用代表外设寄存器及其位的预定义 C 变量。这些变量列于编译器
include目录下的器件特定头文件中。关于哪些外设共用哪些引脚的信息，请参见具
体器件的数据手册。

对于本节中的示例，端口D和端口B引脚与默认禁止的外设复用。惟一的问题在于这些
引脚默认设置为模拟 I/O，因此需要将它们设置为数字 I/O。对于端口D：

ANSELD = 0x0; // set to digital I/O (not analog)

器件引脚连接至器件的数字 I/O端口（PORT）或锁存器（LAT）寄存器。本示例中使用
LATD和LATB。宏LEDS_ON_OFF赋值给两个锁存器。对于端口D：

LATD = LEDS_ON_OFF; // write to port latch - RD[0:3] = LED[0:3]

此外，还有一个寄存器用于指定引脚的方向是输入还是输出，它称为TRIS寄存器。本
节的示例中使用TRISD和TRISB。将位设置为0可将引脚设为输出，将位设置为1可将
引脚设为输入。对于端口D：

TRISD = 0x0; // set all port bits to be output
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2. 使用_delay()函数使LED闪烁

本示例在上一示例代码的基础上进行修改。本代码不仅点亮LED，还将使LED交替
闪烁。

#include <xc.h>

// PIC16F1719 Configuration Bit Settings
// For more on Configuration Bits, consult your device data sheet

// CONFIG1
#pragma config FOSC = ECH     // External Clock, 4-20 MHz
#pragma config WDTE = OFF     // Watchdog Timer (WDT) disabled
#pragma config PWRTE = OFF    // Power-up Timer disabled
#pragma config MCLRE = ON     // MCLR/VPP pin function is MCLR
#pragma config CP = OFF       // Flash Memory Code Protection off
#pragma config BOREN = ON     // Brown-out Reset enabled
#pragma config CLKOUTEN = OFF // Clock Out disabled.
#pragma config IESO = ON      // Internal/External Switchover on
#pragma config FCMEN = ON     // Fail-Safe Clock Monitor enabled

// CONFIG2
#pragma config WRT = OFF      // Flash Memory Self-Write Protect off
#pragma config PPS1WAY = ON   // PPS one-way control enabled
#pragma config ZCDDIS = ON    // Zero-cross detect disabled
#pragma config PLLEN = OFF    // Phase Lock Loop disable
#pragma config STVREN = ON    // Stack Over/Underflow Reset enabled
#pragma config BORV = LO      // Brown-out Reset low trip point
#pragma config LPBOR = OFF    // Low-Power Brown Out Reset disabled
#pragma config LVP = OFF      // Low-Voltage Programming disabled

#define LEDS_ON_OFF 0x05
#define LEDS_OFF_ON 0x0A
#define INSTR_CYCLE_DELAY 25000

void main(void) {

    // Port D access
    ANSELD = 0x0; // set to digital I/O (not analog)
    TRISD = 0x0;  // set all port bits to be output

    // Port B access
    ANSELB = 0x0; // set to digital I/O (not analog)
    TRISB = 0x0;  // set all port bits to be output

    while(1) { 

        LATD = LEDS_ON_OFF; // RD[0:3] = LED[0:3]
        LATB = LEDS_ON_OFF; // RB[0:3] = LED[4:7]

        // delay value change 

        _delay(INSTR_CYCLE_DELAY); // delay in instruction cycles

        LATD = LEDS_OFF_ON; // RD[0:3] = LED[0:3]
        LATB = LEDS_OFF_ON; // RB[0:3] = LED[4:7]
        _delay(INSTR_CYCLE_DELAY); // delay in instruction cycles

    }
    return;
}

请参见第2.1节

请参见第2.2节
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2.1 while()循环和变量值

要使端口D 和端口B上的LED 发生变化，需在循环的第一部分为端口赋值宏
LEDS_ON_OFF，然后在循环的第二部分为端口赋值互补宏LEDS_OFF_ON。使用了
while(1) { }执行循环。

2.2 _delay()函数

由于执行速度在大多数情况下都会导致LED的闪烁速度超出人眼的识别能力，因此需
要降低执行速度。_delay()是编译器的内置函数。

有关内置延时函数的更多详细信息，请参见《MPLAB® XC8 C编译器用户指南》
（DS50002053D_CN）。
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3. 使用中断作为延时在LED上递增计数

本示例在上一示例代码的基础上进行修改。尽管上一示例中的延时循环对于降低循
环执行速度很有用，但是会在程序中引入停滞时间。为避免这一问题，可使用定时器
中断。

#include <xc.h>

// PIC16F1719 Configuration Bit Settings
// For more on Configuration Bits, consult your device data sheet

// CONFIG1
#pragma config FOSC = ECH     // External Clock, 4-20 MHz
#pragma config WDTE = OFF     // Watchdog Timer (WDT) disabled
#pragma config PWRTE = OFF    // Power-up Timer disabled
#pragma config MCLRE = ON     // MCLR/VPP pin function is MCLR
#pragma config CP = OFF       // Flash Memory Code Protection off
#pragma config BOREN = ON     // Brown-out Reset enabled
#pragma config CLKOUTEN = OFF // Clock Out disabled.
#pragma config IESO = ON      // Internal/External Switchover on
#pragma config FCMEN = ON     // Fail-Safe Clock Monitor enabled

// CONFIG2
#pragma config WRT = OFF      // Flash Memory Self-Write Protect off
#pragma config PPS1WAY = ON   // PPS one-way control enabled
#pragma config ZCDDIS = ON    // Zero-cross detect disabled
#pragma config PLLEN = OFF    // Phase Lock Loop disable
#pragma config STVREN = ON    // Stack Over/Underflow Reset enabled
#pragma config BORV = LO      // Brown-out Reset low trip point
#pragma config LPBOR = OFF    // Low-Power Brown Out Reset disabled
#pragma config LVP = OFF      // Low-Voltage Programming disabled

// Interrupt function 

void interrupt isr(void){
// only process Timer0-triggered interrupts
if(INTCONbits.TMR0IE && INTCONbits.TMR0IF) {

            // static variable for permanent storage duration
            static unsigned char portValue;
            // write to port latches
            LATD = ++portValue;      // RD[0:3] = LED[0:3]
            LATB = (portValue >> 4); // RB[0:3] = LED[4:7]
            // clear this interrupt condition
            INTCONbits.TMR0IF = 0;

}
}

void main(void){

    // Port D access
    ANSELD = 0x0; // set to digital I/O (not analog)
    TRISD = 0x0;  // set all port bits to be output

    // Port B access
    ANSELB = 0x0; // set to digital I/O (not analog)
    TRISB = 0x0;  // set all port bits to be output

请参见第3.1节
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    // Timer0 setup 

    OPTION_REG = 0xD7; // timer 0 internal clock, prescaler 1:256
    INTCONbits.TMR0IE = 1; // enable interrupts for timer 0
    ei(); // enable all interrupts

    while(1);

return;
}

3.1 中断函数isr()

可使用interrupt说明符使函数成为中断函数。由于这一中断函数可能必须处理多个
中断源，因此添加了相关代码以确保计数器portValue仅在Timer0产生中断时递增。

3.2 Timer0设置

由于变量值更改在中断服务程序中执行，因此还需要向主程序中添加相关代码以使能
和设置定时器、允许定时器中断以及更改锁存器赋值。

要允许所有中断，请使用xc.h中定义的ei()。

请参见第3.2节
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4. 使用A/D在LED上显示电位器值

本示例与上一示例使用相同的器件以及端口B和端口D上的LED。但在本示例中，将使
用演示板上电位器的值通过端口A提供A/D输入，然后进行转换并显示在LED上。

代码无需手动编写，而是使用MPLAB代码配置器（MPLAB Code Configurator，MCC）  
生成。MCC 是一款插件，可在MPLAB X IDE 菜单Tools>Plugins（工具> 插件）的  
Available Plugins（可用插件）选项卡下安装。有关如何安装插件的更多信息，请参 
见MPLAB X IDE帮助。

有关MCC的信息（包括《MPLAB®代码配置器用户指南》（DS40001725B_CN）），
请访问MPLAB代码配置器网页：

http://www.microchip.com/mplab/mplab-code-configurator

本示例中的MCC GUI设置如以下各图所示。

图2： ADC项目系统资源配置

http://www.microchip.com/mplab/mplab-code-configurator
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图3： ADC项目ADC资源配置

RA0至AN0映射将在图4中的选择完成后显示。
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图4： ADC项目ADC引脚资源——网格
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图5： ADC项目引脚资源配置

在图6中选中引脚RB0:3和RD0:3后，这些引脚将出现在上面的窗口中。

图4中之前选中的是RA0。

在窗口中显示后，可为每个引脚选择引脚配置。
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图6： ADC项目GPIO引脚资源——网格
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图7： ADC项目GPIO引脚资源——封装
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按照上述各图配置完代码后，请单击“Project Resources”（项目资源）窗口上的 
Generate（生成）按钮。通过MCC生成的代码是模块化的。因此，主程序代码、系统
代码和外设代码均位于单独的文件中。此外，每个外设都有自己的头文件。

向程序中添加功能时始终需要编辑main.c。请查看生成的文件以找到您的代码中可能
需要的任何函数或宏。

图8： 通过MCC生成的代码的ADC项目树
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4.1 main.c修改后的代码

main.c模板文件已经过编辑，如下所示。部分注释用< >括起，表示已删除。新添加 
到main()中的代码以红色显示。

/**
  Generated Main Source File

<See generated main.c file for file information.>
 */

/*
  (c) 2016 Microchip Technology Inc. and its subsidiaries. You may use
  this software and any derivatives exclusively with Microchip
  products.

<See generated main.c file for additional copyright information.>
 */

#include "mcc_generated_files/mcc.h"

/*
                         Main application
 */
void main(void) {
    // initialize the device
    SYSTEM_Initialize();

    // <No interrupts used - see generated main.c file for code.> 
    
    while (1) {

        // Start A/D conversion 

        ADC_StartConversion(channel_AN0);
        
        // Wait for ADC to complete 

        while(!ADC_IsConversionDone());
        
        // Write to Port Latches 

        LATD = ADRESH; // RD[0:3] = LED[0:3]
        LATB = (ADRESH >> 4); // RB[0:3] = LED[4:7]

    }
}
/**
 End of File
 */

4.2 启动A/D转换

使用adc.c模块中的如下函数：

void ADC_StartConversion(adc_channel_t channel)

变量channel属于adc.h中定义的typedef adc_channel_t。对于本示例，电位器输 
入位于RA0上，因此选择channel_AN0。

请参见第4.2节

请参见第4.3节

请参见第4.4节
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4.3 等待ADC完成

使用adc.c模块中的如下函数：

bool ADC_IsConversionDone()

该函数会返回ADCON0bits.GO_nDONE位（在器件头文件中定义）的取反值。但是，
main while循环中需要该位的实际值，因此需要将返回值再次取反。

4.4 写入端口锁存器

由于只有8个LED，因此仅显示ADRESH的值。低4位通过LATD显示在LED 0至LED 3  
上，高4位会先进行移位，以便能够通过LATB显示在LED 4至LED 7上。
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5. 在LED上显示EEPROM数据值

本示例使用另一款Microchip器件PIC16F1939 MCU来演示如何读写EEPROM数据 
（EEData）。读取的值显示在端口D和端口B LED上。

再次使用MPLAB代码配置器（MCC）来生成大部分代码。欲了解如何安装MCC和获
取MCC用户指南的信息，请参见： 
第4节“使用A/D在LED上显示电位器值”。

本示例中的MCC GUI设置如以下各图所示。

图9： EEDATA项目系统资源配置
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图10： EEDATA项目存储器资源配置
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图11： EEDATA项目引脚资源配置

当图12中选中引脚RB0:3和RD0:3后，这些引脚将出现在上面的窗口中。

在窗口中显示后，可为每个引脚选择引脚配置。
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图12： EEDATA项目GPIO引脚资源——网格
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图13： EEDATA项目GPIO引脚资源——封装
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按照上述各图配置完代码后，请单击“Project Resources”（项目资源）窗口上的 
Generate（生成）按钮。通过MCC生成的代码是模块化的。因此，主程序代码、系统
代码和外设代码均位于单独的文件中。此外，每个外设都有自己的头文件。

向程序中添加功能时始终需要编辑main.c。请查看生成的文件以找到您的代码中可能
需要的任何函数或宏。

图14： 通过MCC生成的代码的EEDATA项目树
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5.1 main.c修改后的代码

main.c模板文件已经过编辑，如下所示。部分注释用< >括起，表示已删除。新添加 
的代码以红色显示。

/**
  Generated Main Source File

<See generated main.c file for file information.>
 */

/*
  (c) 2016 Microchip Technology Inc. and its subsidiaries. You may use
  this software and any derivatives exclusively with Microchip
  products.

<See generated main.c file for additional copyright information.>
 */

#include "mcc_generated_files/mcc.h"

#define NUM_EE_VALUES 64
#define INSTR_CYCLE_DELAY 25000

/*
                         Main application
 */
void main(void) {
    // initialize the device
    SYSTEM_Initialize();

    // <No interrupts used - see generated main.c file for code.> 

    // Declare RAM array, loop variable 

    volatile unsigned char RAMArray[NUM_EE_VALUES];
    unsigned char i;

    // Write initial values to EEPROM Data 
    PIR2bits.EEIF = 0x0; // clear write flag

    for(i=0; i<NUM_EE_VALUES; i++){
        DATAEE_WriteByte(_EEADRL_EEADRL_POSN + i, i);
        while(!PIR2bits.EEIF);  // check for write finished
        PIR2bits.EEIF = 0x0;
    }
    
    while(1){
        // Read from EEPROM and display 
        for(i=0; i<NUM_EE_VALUES; i++){
            RAMArray[i] = DATAEE_ReadByte(_EEADRL_EEADRL_POSN + i);
            LATD = RAMArray[i]; // RD[0:3] = LED[0:3]
            LATB = (RAMArray[i] >> 4); // RB[0:3] = LED[4:7]
            _delay(INSTR_CYCLE_DELAY); // delay value change
        }

请参见第5.2节

请参见第5.3节

请参见第5.4节
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        // Write to EEPROM in reverse order
        for(i=0; i<NUM_EE_VALUES; i++){
            DATAEE_WriteByte(_EEADRL_EEADRL_POSN + 
              (NUM_EE_VALUES - 1) - i, RAMArray[i]);
            while(!PIR2bits.EEIF);  // check for write finished
            PIR2bits.EEIF = 0x0;
        }

    };

}
/**
 End of File
 */

5.2 EEData相关变量

用于存储EEData读 /写数据的变量必须与读 /写函数原型中指定的类型匹配，函数原型
由mcc.h引用且可在memory.h中找到：

void DATAEE_WriteByte(uint8_t bAdd, uint8_t bData);
uint8_t DATAEE_ReadByte(uint8_t bAdd);

从stdint.h引用时，uint8_t与unsigned char相同。

5.3 写入EEData

本示例中两次写入EEData：第一次用于初始化EEData存储器中的值，第二次用于更
改数据以实现动态显示。

写入EEData需 要 多 个 周期，因 此 使 用 写 完 成 标 志 来 确 定 写 操 作 何 时 完成
（PIR2bits.EEIF）。该标志最初为清零状态，并且会在每次写操作完成时再次清
零。（该标志必须用软件清零。）

5.4 读取EEData

写入EEData后，存储器值会被读入RAM数组，然后显示在端口D和端口B LED上。该 
写循环中使用RAM数组中的值更改EEData存储器中的值。

由于执行速度在大多数情况下都会导致LED的闪烁速度超出人眼的识别能力，因此需
要再次使用_delay()函数（同例2）来降低执行速度。
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A. 在MPLAB X IDE中运行代码

按如下步骤创建一个项目：

1. 启动MPLAB X IDE。

2. 从 IDE中启动新建项目向导（File>New Project（文件>新建项目））。

3. 按照屏幕提示创建一个新项目：

a) Choose Project（选择项目）：选择“Microchip Embedded”（Microchip
嵌入式），然后选择“Standalone Project”（独立项目）。

b) Select Device（选择器件）：选择示例器件。

c) Select Header（选择调试头）：无。

d) Select Tool（选择工具）：选择硬件调试工具，SNxxxxxx。如果调试工具名
称下未显示序列号（Serial Number，SN），请确保调试工具已正确安装。
有关详细信息，请参见调试工具文档。

e) Select Plugin Board（选择接插板）：无。

f) Select Compiler（选择编译器）：选择XC8（最新版本号）[bin文件夹位
置 ]。如果XC8下未显示编译器，请确保编译器已正确安装且MPLAB X IDE
已获知（Tools>Options（工具>选项），Embedded（已安装工具）按钮，
Build Tools（编译工具）选项卡）。有关详细信息，请参见MPLAB XC8和
MPLAB X IDE文档。

g) Select Project Name and Folder（选择项目名和文件夹）：为项目命名。

创建完项目后，根据您使用的示例执行以下操作之一：

1. 对于示例1、2和3，创建一个文件来保存示例代码：

a) 右键单击Projects（项目）窗口中的项目名称。选择New>Empty File（新建
>空白文件）。随即将显示New Empty File（新建空白文件）对话框。

b) 在“File name”（文件名）下输入名称。

c) 单击Finish（完成）。

d) 从本用户指南中剪切示例代码并粘贴到空白编辑器窗口中，然后选择
File>Save（文件>保存）。

2. 对于示例4和5，请按照每个部分中的说明使用MCC生成代码，然后用所显示的
代码编辑main.c文件。

最后，编译代码并下载到器件中，然后选择Debug Run（调试运行）执行代码。演示
板上的LED将交替点亮。单击Halt（暂停）结束执行。

图15： 工具栏图标

调试运行 暂停
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B. 获取软件和硬件

对于本文档中的MPLAB XC8项目，装有PIC16F1719或PIC16F1939 MCU的Explorer  
8板由9V外部电源供电，并使用标准（ICSP™）通信。使用MPLAB X IDE进行开发。

B.1 获取MPLAB X IDE和MPLAB XC8 C编译器

可从以下网址找到MPLAB X IDE v3.35及以上版本：

http://www.microchip.com/mplab/mplab-x-ide

可从以下网址找到MPLAB XC8 C编译器v1.38及以上版本：

http://www.microchip.com/mplab/compilers

B.2 获取MPLAB代码配置器（MCC）

可从以下网址找到MCC v3.15及以上版本：

http://www.microchip.com/mplab/mplab-code-configurator

B.3 获取PIC® MCU

可从以下网址找到本示例中使用的PIC MCU：

http://www.microchip.com/PIC16F1719

http://www.microchip.com/PIC16F1939

B.4 获取并设置Explorer 8板

可从以下网址找到Explorer 8开发工具包（DM160228）：

http://www.microchip.com/DM160228

下表列出了跳线设置。  

表1-1： 项目的跳线选择

跳线 选择 说明

J2 BRD+5V 通过电源（而非USB）为开发板供电

J14 +5V 器件电源电压

J24 开路 使用+5V（而非3.3V）

J7 闭合 使能端口D <RD0:3>上的LED

J21 闭合 使能端口B <RB0:3>上的LED

J36 OSC1至RA7 OSC1 CLKIN（8 MHz外部振荡器）

J37 OSC2至RA6 OSC2 CLKOUT（8 MHz外部振荡器）

J51 PGD至RB7 ICSPDAT

J52 PGC至RB6 ISCPCLK

表1-2： 未使用的跳线选择

跳线 选择 说明

JP2 闭合 不使用LCD

J22、J23、J53和J54 开路 不使用LCD

J15和J16 开路 不使用Digilent Pmod™连接器

J43、J44、J45、J46和J47 开路 不使用mikroBUS

J41、J42、J48、J49和J50 开路 不使用mikroBUS

J4和J31 VCAP 不使用RA5和RA4

http://www.microchip.com/mplab/mplab-x-ide
http://www.microchip.com/mplab/compilers
http://www.microchip.com/mplab/mplab-code-configurator
http://www.microchip.com/PIC16F1719
http://www.microchip.com/PIC16F1939
http://www.microchip.com/DM160228
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B.5 获取Microchip调试工具

可在如下开发工具网页中找到仿真器和调试器：

http://www.microchip.com/development-tools

http://www.microchip.com/development-tools
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